
A+ Practical Application 220-802 Cram Notes

1. Operating Systems

1.1 Compare and contrast the features and requirements of various Microsoft Operating Systems

1.2 Given a scenario, install, and configure the operating system using the most appropriate method

1.3 Given a scenario, use appropriate command line tools

1.4 Given a scenario, use appropriate operating system features and tools

1.5 Given a scenario, use Control Panel utilities (the items are organized by “classic view/large icons” 
in Windows)

1.6 Setup and configure Windows networking on a client/desktop

1.7 Perform preventive maintenance procedures using appropriate tools

1.8 Explain the differences among basic OS security settings

1.9 Explain the basics of client-side visualization

2. Security

2.1 Apply and use common prevention methods

2.2 Compare and contrast common security threats

2.3 Implement security best practices to secure a workstation. 

2.4 Given a scenario, use the appropriate data destruction/disposal method

2.5 Given a scenario, secure a SOHO wireless network

2.6 Given a scenario, secure a SOHO wired network

3. Mobile Device

3.1 Explain the basic features of mobile operating systems

3.2 Establish basic network connectivity and configure email

3.3 Compare and contrast methods for securing mobile devices

3.4 Compare and contrast hardware differences in regards to tablets and laptops

3.5 Execute and configure mobile device synchronization

4. Troubleshooting

4.1 Given a scenario, explain the troubleshooting theory

4.2 Given a scenario, troubleshoot common problems related to motherboards, RAM, CPU and power 
with appropriate tools

4.3 Given a scenario, troubleshoot hard drives and RAID arrays with appropriate tools
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4.4 Given a scenario, troubleshoot common video and display issues

4.5 Given a scenario, troubleshoot wired and wireless networks with appropriate tools

4.6 Given a scenario, troubleshoot operating system problems with appropriate tools

4.7 Given a scenario, troubleshoot common security issues with appropriate tools and best practices

4.8 Given a scenario, troubleshoot, and repair common laptop issues while adhering to the appropriate 
procedures

4.9 Given a scenario, troubleshoot printers with appropriate tools

1. Operating Systems

1.1 Compare and contrast the features and requirements of various Microsoft Operating Systems

Windows 2000

1. Hardware requirements:

Hardware component Windows 2000 Prof. Windows 2000 Ser/ Ad Ser.

Processor Pentium/133MHz Pentium/133MHz

Memory 64MB 256MB

HD space 640MB 1GB

Display VGA or better VGA or better

Network card Optional Optional

CD ROM Drive Required Required (unless loading from network)

2. When you install Windows 2000 in the same folder as that of Windows 95/ Windows 98/ Windows 
NT, the operating system gets upgraded to Windows 2000.

3. TCP/IP protocol stack is installed by default when you install Windows 2000 on a computer.

4. You can use Regional Options to support additional languages on your computer. With the support of 
additional languages, you will be able to edit documents written in those languages. You can also set 
locale specific to any region using this Option.

5. The Windows 2000 Performance tool is composed of two parts:

a. System Monitor:  With System Monitor, you can collect and view real-time data about 
memory, disk, processor, network, and other activity in chart (graph), histogram, or report form

Some of the important System Monitor counters are:

1. Memory>Available Mbytes: measures the amount of physical memory that is 
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available. Typically > 4MB. If less than 4 MB, consider adding more memory.

2. Memory>Pages/Sec: Shows the number of times that the disk has been accessed, 
because requested information was not available in memory. If the value of the counter is
not below 20, you should add more memory. A value of 4 or 5 is typical.

3. Paging File>%Usage: Indicates the % of allocated page file utilization. Should be less 
than 99%.

4. Processor>%Processor Time: measure the time that the processor is busy. Should be 
typically less than 80%

5. Processor>Interrupts/Sec: Indicates the average number of hardware interrupts that the
processor receives each second. If more than 3,500, you can suspect a program or faulty 
hardware.

6. PhysicalDisk>%Disk Time: Measures the amount of time that the physical disk is busy
servicing read or write requests. If more than 90%, you can improve the performance by 
adding another disk channel.

7. PhysicalDisk>%Current Disk Queue Length: indicates the number of pending disk 
requests that need to be processed. The value should be less than 2. The disk problems 
might arise from less memory, resulting in usage of excessive paging. Ensure that the 
memory is sufficient before attending to the disk problem.

8. LogicalDisk > %Free Space counter: Indicates the amount of logical disk’s free disk 
space. Typical value is 10% or above. 

b. Performance Logs and Alerts: Through Performance Logs and Alerts you can configure logs 
to record performance data and set system alerts to notify you when a specified counter's value is
above or below a defined threshold.

6. Event Viewer maintains logs about program, security, and system events. You can use Event Viewer 
to view and manage the event logs, gather information about hardware and software problems, and 
monitor Windows 2000 security events.

7. To open Event Viewer, click 'Start', point to 'Settings', and then click 'Control Panel'. Double-click 
'Administrative Tools', and then double-click Event Viewer.

8. Encrypting File System (EFS) keeps your documents safe from intruders who might gain 
unauthorized physical access to your sensitive stored data by stealing your laptop or Zip disk, or by 
other means.

9. You need to ensure the following before the upgrade:

a. The hardware is adequate for upgrading to Windows 2000 Professional

b. Also, check the hardware, software adequacy by running “Winnt32.exe / checkupgradeonly”. 
Note that the switch “checkupgradeonly” will output a report on the adequacy of hardware and 
software. It will also warn you if any applications need upgrade packs, which may be obtained 
from respective application vendors, if available. If the software upgrade pack is not installed for
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any application, the application may be rendered unusable!

10. If you are creating a Striped volume on a new Windows 2000 machine, it can only be created on 
dynamic disks. However, if you are upgrading a Windows NT computer to Windows 2000, any existing 
stripe set will be supported.

11. For creating Stripe set with parity, we need at least 3 disk volumes.

12. Placing the paging file on different physical disks is optimal. This will improve faster access to the 
Paging file, and also distribute the load.

13. Microsoft Internet Explorer and Windows Explorer can be used for assigning Share and NTFS 
permissions on a Windows 2000 computer.

14. To insert a new file extension, you use Windows explorer, and select the application. Then, Tools -> 
Folder Option -> File Types. Configure the extension appropriately.

15. Windows 2000 Operating systems support 5 different volume types:

a. Simple volumes :A simple volume consists of a formatted disk on a single hard disk.

b. Spanned volumes: A Spanned volume consists of disk space on more than one hard disk.

c. Striped volumes: A Striped volume has disk space on 2 or more disks. The disk spaces must 
be same on all disks. Fastest disk access among all volume types. RAID level 0.

d. Mirrored volumes: A mirrored volume consists of a Simple volume that is mirrored in total, 
onto a second dynamic disk. Provides highest level of fault tolerance. RAID level 1

e. RAID-5 volumes: A RAID-5 volume consists of identical sized disk space located on three or 
more dynamic disks. Here any single disk failures can be recovered. RAID level 5

f. Note that Windows 2000 Professional doesn’t support Disk Mirroring, RAID-5 volumes, 
where as other Windows 2000 Operating Systems (2000 Server, Advanced Server) support.

16. Fault tolerance boot disk is a floppy disk that enables you to boot a computer in the event that the 
first disk in a mirrored volume fails. If you mirror the installation folder in a Windows 2000 Server, you
will not be able to boot because boot.ini points to the first volume. Therefore, you need to create a fault 
tolerance boot disk that contain an appropriately edited Boot.ini file, that points to the mirrored volume.

17. By default, you can start recovery console (in Windows 2000) using,

a. The Windows 2000 Professional Setup Disks

b. From the CD ROM drive using Windows 2000 Professional CD (if the CD –ROM drive is 
bootable). 

c. Also, you can have “Recovery Console” as a start up option by typing \i386\winnt32.exe 
/cmdcons at the command prompt, after switching to the CD ROM drive letter.

18. Windows 2000 provides two versions of Registry Editor
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a. Regedt32.exe (32-bit): Regedt32.exe is automatically installed in the systemroot\system32 
folder.

b. Regedit.exe (16-bit):  Regedit.exe is automatically installed in the systemroot folder. c. 
Regedit.exe is primarily used for its search capabilities as it doesn’t support all functions and 
data types.

19. On a Windows 2000 computer, the default spool folder is located at: 
Systemroot\System32\spool\printers. For example, if the OS is residing on C drive, the default location 
will be: “C:\\WINNT\System32\spool\printers”.You can access this location through:
Start -> Printers -> File -> Server Properties -> Advanced tab. Type in the new spool location over the 
default location.

20. Up-grade to Windows 2000:

a. You can upgrade Windows 95/98, Windows NT 3.51Work Station, Windows NT 4.0 WS can 
be upgraded to Windows 2000 Professional.

b. You can’t upgrade Windows 3.1 and Windows for workgroups to Windows 2000 Professional.
If you need to install 2000 Prof. On Windows 3.x, you need to upgrade first to Windows 95/98 
or NT and then upgrade to 2000 Prof. It is easy to do a clean install of Windows 2000 on 
Windows 3.x machines.

c. You need to ensure the following before the upgrade:

a. The hardware is adequate for upgrading to Windows 2000 Professional

b. Also, check the hardware, software adequacy by running Winnt32.exe / checkupgradeonly.

Note that the switch “checkupgradeonly” will output a report on the adequacy of hardware and 
software. It will also warn you if any applications need upgrade packs, which may be obtained 
from respective application vendors, if available. If the software upgrade pack is not installed for
any application, the application may be rendered unusable!

c. It is also recommended, if you are upgrading on a large population, to upgrade only one work 
station, and check whether the application softwares are running properly. 

21. By default, Windows 2000 stores a user’s profile in the C:\Documents and Settings\ user_name 
folder on the computer the user logs on.When a new user logs on, his initial user profile is an exact copy
of either the local or domain-wide “default user” profile folder.The local default user profile folder is 
located in %root%\Documents and Settings.

22. If you have installed Windows 2000 in C drive, it is C:\Documents and Settings. 

23. Pressing F8 during boot process in Windows 2000 desk top bring up the following options:

a. Safe Mode: Safe Mode loads only the drivers necessary to get the desk top up and running. 
The drivers loaded with Safe Mode include mouse, monitor, keyboard, hard drive, and standard 
video driver.
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b. Safe Mode with Networking: Safe Mode with Networking is same as Safe Mode with 
networking enabled.

c. Safe Mode with Command prompt: Safe Mode with Command Prompt option loads the 
command prompt instead of Windows 2000 graphical interface.

d. Enable Boot Logging

e. Enable VGA Mode: Enable VGA Mode option loads a standard VGA driver. This option is 
good if you have any problem with newly installed video driver.

f. Last Known Good Configuration: Last Known Good Configuration enables the desk top to 
load the configuration that was stored when it was booted successfully last time. This option 
can’t take care of any hardware related problems.

g. Debugging Mode: The Debugging Mode option runs the Kernel Debugger, if that utility is 
installed.

h. Boot Normally: The Boot Normally is same as not pressing the F8 key. The Windows boots 
normally

24. You can access Task Manager by pressing <Alt> <Ctrl> <Del>. The applications tab lists all the 
applications that are currently running on the computer. The current status of the application is also 
displayed as either “Running” or “not responding” or “stopped”. 

25. Blue screen messages are also called STOP messages. You will not be allowed to proceed, when a 
blue screen message appears. The most likely cause of blue screen messages are:

a. Boot sector virus

b. IRQ/ IO address conflicts.

c. You can check for any boot sector virus, and also for any conflicting IRQ / IO addresses.

26. You can configure support for multiple displays on your Windows 2000 computer. This is done 
through the use of Control Panel -> Display -> Settings. A Windows 2000 computer can support up to 
ten display monitors at the same time. Use additional video cards as required.

27. On a Windows 2000 computer, disk quotas can be used on NTFS volumes. Windows Explorer can 
be used to configure and monitor disk quotas.

28. On a Windows computer, you can use the View tab in Folder Options applet in the Control Panel to 
show / hide files and folders that have “Hidden” attribute set. You can also use Windows Explorer -> 
Tools -> Folder Options -> View tab. 

29. If you want to install Windows 2000 on the same partition as that of Windows 98, install 2000 
Professional either on the FAT file systems or on the FAT32 for dual boot. Windows 98 supports FAT 
(FAT16) and FAT32. It doesn’t support NTFS file system. 

30. The various file systems supported by Windows 2000 are:

a. FAT: Also called FAT16, supported by all Microsoft Operating Systems.
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b. FAT32: Also supported by Win 95 OSR2 and Win98

c. NTFS: This is not supported by Win95/98

d. CDFS (Compact Disk File System, used to access CDs)

e. UDF (Universal Disk Format, used to access DVDs)

31. If you want to have dual boot between Windows NT 4 and Windows 2000, ensure that Service Pack 
4 is installed on Windows NT 4. This is required since Windows 2000 upgrades the NTFS to NTFS 5. 
NT4 requires Service Pack 4 to read and write to NTFS 5.

32. If you encrypt a folder on an NTFS volume, all files and sub folders created in the encrypted folder 
are automatically encrypted. Therefore, it is recommended that you use encryption at the parent folder 
level.

33. Also note that you can’t encrypt a file or folder that is compressed. If you want to encrypt a file or 
folder that is compressed, you need to first decompress the file or folder and then encrypt. Only NTFS 
volumes support file or folder encryption. 

34. You don’t need to have a network card installed for successful installation of Windows 2000 
Professional. You can use loop back adapter for this purpose and proceed with the installation. Network 
card can be installed at a later time, when required. 

35. In Windows 2000 computer, Disk Management is used to create, manage, and delete simple 
volumes, spanned volumes, mirrored volumes, striped, and stripe set with parity volumes. Disk 
Administrator is NT 4 tool and is not available in Windows 2000.

36. Only Windows NT Server 4 and Windows NT Server 3.51 can be upgraded to Windows 2000 
Server. Windows NT Workstation 4.0 or Windows 95/98 can't be upgraded to 2000 Server.

Windows XP

1. In Windows XP computer, you can use Start -> Windows Update to connect to the Microsoft site. 
Windows Update is a catalog of items such as drivers, patches, the latest help files, and Internet 
products that you can download to keep your computer up to date. You must be logged on as an 
administrator or a member of the Administrators group in order to access the Product Updates section of
Windows Update for downloading help files.

2. XP Professional supports multiple processors, multiple monitors (up to 9), Group Policy, Encrypting 
File System, Dynamic Disks, IIS, a built in backup program, and advanced networking capabilities 
(such as IPSec.) All of these features are missing from XP Home Edition. Another important distinction 
between the two versions is that XP Home Edition cannot join a Windows NT/2000/2003 domain.

3. Windows XP Operating System comes in the following flavors:

a. Windows XP Home: The basic XP OS intended for home users

b. Windows XP Professional: The XP OS intended for business users

c. Windows XP Media Center Edition: Windows Media Center provides a large-font, remotely 
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accessible interface ("10-foot user interface") for television viewing on the computer as well as 
recording and playback, a TV guide, DVD playback, video playback, photo viewing, and music 
playback.

d. Windows XP Table PC: This edition is intended for specially-designed notebook/laptop 
computers called tablet PCs. Windows XP Tablet PC Edition is compatible with a pen-sensitive 
screen, supporting handwritten notes and portrait-oriented screens.

4. Boot process (F8) in Windows XP desk top bring up the following options:

a. Safe Mode: This option uses a minimal set of device drivers and services to start Windows. 
The drivers loaded with Safe Mode include mouse, monitor, keyboard, hard drive, and standard 
video driver.

b. Safe Mode with Networking: This option uses a minimal set of device drivers and services to 
start Windows together with the drivers that you must have to load networking.

c. Safe Mode with Command Prompt: This option is the same as Safe mode, except that 
Cmd.exe starts instead of Windows Explorer.

d. Enable VGA Mode: This option starts Windows in 640 x 480 mode by using the current video
driver (not Vga.sys). This mode is useful if the display is configured for a setting that the 
monitor cannot display.

Note: Safe mode and Safe mode with Networking load the Vga.sys driver instead.

e. Last Known Good Configuration: This option starts Windows by using the previous good 
configuration.

f. Directory Service Restore Mode: This mode is valid only for Windows-based domain 
controllers. This mode performs a directory service repair.

g.  Debugging Mode: This option turns on debug mode in Windows. Debugging information can
be sent across a serial cable to another computer that is running a debugger. This mode is 
configured to use COM2.

h. Enable Boot Logging: This option turns on logging when the computer is started with any of 
the Safe Boot options except Last Known Good Configuration. The Boot Logging text is 
recorded in the Ntbtlog.txt file in the %SystemRoot% folder.

i. Starts Windows Normally: This option starts Windows in its normal mode.

j. Reboot: This option restarts the computer.
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k. Return to OS Choices Menu: On a computer that is configured to starting to more than one 
operating system, this option returns to the Boot menu.

5. You can configure support for multiple displays on your Windows XP computer. This is done through
the use of Control Panel -> Display -> Settings. A Windows XP computer can support up to ten display 
monitors at the same time. Use additional video cards as required.

6. The Device Manager (It can be accessed using Add/Remove Hardware in XP) lists all the hardware 
devices installed on your system. You can also update any existing drivers, as well as change the 
hardware settings. You use Add/Remove Hardware to install new hardware. Accessibility options are 
primarily used to configure the keyboard, display, and mouse options on a computer to accommodate 
the users who are physically handicapped. The Add/ Remove Programs is used to install/uninstall 3rd 
party software. This is also used for installing/uninstalling Windows XP optional components.

7. Features supported by XP

a. On readable/writable disks, Microsoft Windows XP Professional supports the NTFS file 
system and three file allocation table (FAT) file systems: FAT12, FAT16, and FAT32. On 
CDROM and DVD media, Windows XP Professional supports two file systems: Compact Disc 
File System (CDFS) and Universal Disk Format (UDF).

b. While installing XP, if you have a standard desktop PC that uses integrated drive electronics 
(IDE) disk drives, then these will be detected during setup. If, however, you use SCSI disks or 
have Redundant Array of Independent Disk (RAID) storage systems, you will see, shortly after 
the reboot, the following line of text displayed at the bottom of the screen:
“Press F6 if you need to install a third party SCSI or RAID driver...”

c. Pressing F6 will start a dialog that allows you to configure and install the drivers for your 
SCSI or other disk subsystem controllers. This option is usually used on server platforms that 
use large-capacity, high-speed, fault-tolerant disk subsystems. For most PCs, however, you won't
need to use this option.

d. Windows XP advanced startup options can be accessed by pressing F8 key when prompted 
during the beginning of the Windows XP boot process.

e. On your Windows XP computer, you can use the View tab in Folder Options applet in the 
Control Panel to show / hide files and folders that have “Hidden” attribute set. You can also use 
Windows Explorer -> Tools -> Folder Options -> View tab.

f. You can access Computer Management screen through:
1. MyComputer on Desk Top -> Right Click -> Manage

2. Start -> Programs -> Administrative Tools -> Computer Management

3. One of the frequently used resource in “Computer Management” screen is System 
Tools. System tools contain the following:

1. Event Viewer
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2. System Information 
3. Performance logs
4. Device Manager
5. Shared folders
6. Local Users and Groups

These are very useful tools to a system administrator.

Windows Vista

1.The minimum hardware requirements for installing Vista Operating System (Home Basic/Home 
Premium/Business/Ultimate) are given below:

a. 800 MHz processor and 512 MB of system memory
b. 20 GB hard drive with at least 15 GB of available space
c. Support for Super VGA graphics
d. CD-ROM drive

2. The recommended hardware requirements (for Home Premium/Business/Ultimate) are given as:

a. 1 GHz 32-bit (x86) or 64-bit (x64) processor
b. 1 GB of system memory
c. 40 GB hard drive with at least 15 GB of available space
d. Support for DirectX 9
e. DVDROM drive

3. For Home Basic, the recommended requirements are:

a. 1 GHz 32-bit (x86) or 64-bit (x64) processor
b. 512 MB of system memory
c. 20 GB hard drive with at least 15 GB of available space
d. Support for DirectX 9 graphics 
e. DVD-ROM drive

4. You can upgrade  to Windows Vista Ultimate from Windows XP Home, XP Professional, XP Media 
Center, and XP Tablet PC, Windows 2000 Professional can't be upgraded to Windows Vista directly.

5. Certain versions of Windows Vista uses BitLocker Drive Encryption. BitLocker Drive Encryption is a
full disk encryption feature included with the Ultimate and Enterprise editions of Microsoft's Windows 
Vista and Windows 7 desktop operating systems.

6. In order for BitLocker to operate, the hard disk requires at least two NTFS-formatted volumes: one 
for the operating system (usually C:) and another with a minimum size of 100MB from which the 
operating system boots. BitLocker requires the boot volume to remain unencrypted, so the boot should 
not be used to store confidential information. 

7. Windows Sidebar is a pane on the side of the Microsoft Windows Vista desktop where you can keep 
your gadgets organized and always available. Gadgets are mini programs that give you information at a 
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glance and provide access to frequently used tools. Windows Sidebar helps you to organize your 
gadgets. The Windows sidebar is also available in Windows 7 Operating System.

8. The parental controls built into Windows Vista help parents determine which games their children can
play, which programs they can use, and which websites they can visit, and when. Parents can restrict 
computer use to specific times and trust that Windows Vista will enforce those restrictions, even when 
they're away from home.

9. Windows Vista introduces Sync Center, which enables users to synchronize their data with other 
computers and devices from one common user interface. There are several ways to interact with Sync 
Center, one of which is as a provider of synchronization information. Synchronization information 
consists of a synchronization engine, and the data that it synchronizes.

10. Driver Verifier is included in Windows 7, Windows Vista, Windows 2000, Windows XP, and 
Windows Server 2003 to promote stability and reliability. You can use this tool to troubleshoot driver 
issues. You can start the tool by going to Run > verifier.exe Specifically, in the version of Driver 
Verifier included in Windows Vista:

a. You can start verification of any driver without rebooting, even if Driver Verifier is not already
running.

b. You can start the verification of a driver that is already loaded.

c. You can activate or deactivate most Driver Verifier options without rebooting.

11. The editions below support the Aero Feature:

a. Windows Vista Home Premium

b. Windows Vista Business Edition

c. Windows Vista Ultimate Edition

Windows 7

1.Both the 32 bit and 64 bit versions of Windows 7 require minimum 1 GHz. If you want to run 
Windows 7 on your PC, given below are the hardware requirements:

a. 1 Gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) processor
b. 1 Gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit)
c. 16 GB available hard disk space (32-bit) or 20 GB (64-bit)
d. DirectX 9 graphics device with WDDM 1.0 or higher driver

2. Only 64 bit versions of windows 7 can handle over 4GB of RAM

3. Physical Memory Limits: Windows 7. The following table specifies the limits on physical memory 
for Windows 7.

Version                                       Limit on X86                 Limit on X64
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Windows 7 Ultimate                         4 GB                               192 GB
Windows 7 Enterprise                         4 GB                               192 GB
Windows 7 Professional            4 GB                               192 GB
Windows 7 Home Premium             4 GB                                16 GB
Windows 7 Home Basic              4 GB                                   8 GB
Windows 7 Starter                          2 GB                                 2 GB

4. Windows 7 Professional can be upgraded to only Windows 7 Ultimate. The possible upgrade 
scenarios from one edition of windows 7 to another edition of windows 7 are given below

From Windows 7 Anytime Upgrade to Windows 7

Home Basic                 Home Premium, Professional, Ultimate
Home Premium           Professional, Ultimate
Professional                 Ultimate
Starter                           Home Premium, Professional, Ultimate

5. indows Vista and Windows 7 feature a user interface termed as Aero by Microsoft. This is the default 
interface used by Vista. Aero interface is characterized by the following features:

a. .Glass-like translucent design

b. .Dynamic windows: When you minimize a window, it animates to its place on the taskbar, so 
it's easier to find when you need it.

c. High dots-per-inch (dpi) support: Windows Aero supports high-resolution monitors, so you 
can get a laptop or flat-screen monitor that's smaller in size but shows visually richer, displaying 
high-resolution, easy-to-read images.

d. Live taskbar thumbnails: In Windows Aero, live taskbar thumbnail images display the actual 
contents of both windows that are currently open and those that are minimized in the taskbar. 
When you rest your mouse pointer on a tile on the taskbar, you'll see the "live" contents of that 
window without having to bring it to the foreground.

e. Other features include Windows Flip 3D, and smooth scrolling desktop.

6. Windows XP Mode for Windows 7 makes it easy to install and run your applications for 32-bit 
Windows XP directly from your Windows 7 32-bit or 64-bit based PC. It utilizes virtualization 
technology such as Windows Virtual PC to provide a Virtual Windows XP environment for Windows 7. 
Windows XP Mode provides only Windows 7 Professional, Ultimate, or Enterprise users the flexibility 
to run many older productivity applications in a virtual Windows XP environment on a Windows 7-
based PC.

7. Aero desktop is available in the

a. Windows 7 Home Premium, 
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b. Windows 7 Professional, 

c. Windows 7 Ultimate, and 

d. Windows 7 Enterprise 

6. You can use Region and Language to support additional languages on your Windows 7 computer. 
With the support of additional languages, you will be able to edit documents written in those languages. 
You can also set locale specific to any region using this Option.

7. When you upgrade to Windows 7, you need to ensure that you have software upgrade packs 
available. It is very much possible that an application that was working properly may not work the same
way after the upgrade of OS. You need to contact the vendor for upgrade pack for any application(s) 
you are using. If the upgrade packs are not available, and the application is critical, you may need to 
reconsider the upgradation of OS.

1.2 Given a scenario, install, and configure the operating system using the most appropriate 
method

1. NTFS
a. If you encrypt a folder on an NTFS volume, all files and subfolder created the encrypted 
folder are automatically encrypted. Therefore, it is recommended that you use encryption at the 
parent folder level. Also note that you can’t encrypt a file or folder that is compressed. If you 
want to encrypt a file or folder that is compressed, you need to first decompress the file or folder
and then encrypt. Only NTFS volumes support file or folder encryption. 

b. NTFS 5 supports file encryption, where as NTFS 4 doesn't. You can upgrade NTFS 4 to NTFS
5 on Windows NT 4.0 computer by installing Service Pack 4 or later.

c. Microsoft Internet Explorer and Windows Explorer can be used for assigning Share and NTFS
permissions on a Windows 2000 computer.

d. Disk quotas can only be used on NTFS volumes. This is because only NTFS volumes 
maintain ownership information on files and folders. Windows Explorer can be used to 
configure and monitor disk quotas.

2. A hard disk can have one Primary partition and one Extended partition. An Extended partition can be 
divided into one or more logical partitions. After partitioning the hard disk, each partition need to be 
formatted.  

3. When you have two hard disk drives, the following two combinations are possible:

a. Install the drives one each on primary and secondary controllers and designate both as 
Masters.
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b. Install both the drives on the primary controller and designate one as Master and the other as 
Slave. 

3.  If you are unable to use a USB device, it is likely that the USB is not enabled in the BIOS. This is 
the first thing to be checked while configuring USB port. If the keyboard is USB keyboard, and you are 
unable to enter BIOS configuration, it may need to be replaced with a conventional keyboard for the 
purpose of changing/ verifying the BIOS settings. Note that USB interface need to be enabled in the 
BIOS. 

4. You use Scanners and Cameras to install device drivers for a new scanner or a digital camera. You 
can also set properties, remove a scanner or a camera using the “Scanners and Cameras” applet in the 
Control Panel. Once the Camera or Scanner is installed, you can use the Imaging application to initiate 
the transfer of images from your scanner or camera to your Windows 2000 computer. You can access 
the Imaging application through Start -> Programs -> Accessories -> Imaging. 

5. Traditionally, workstations can have multiple operating systems installed on them but run only one at 
a time. By running virtualization software, the same workstation can be running Window 7 along with 
Windows Server 2008 and Red Hat Enterprise Linux (or almost any other operating system) at the same
time, allowing a developer to test code in various environments as well as cut and paste between them 
within a virtual machine (VM).

6. A Trusted Platform Module (TPM) is a microchip that is built into a computer. It is used to store 
cryptographic information, such as encryption keys. Information stored on the TPM can be more secure 
from external software attacks and physical theft.

1.3 Given a scenario, use appropriate command line tools.

Using FDISK, the following activities can be carried out:

1. Create Partitions: You can create primary and extended partitions. Extended partition holds 
one or more (Up to 23) logical drives.
2. Set Active Partition: FDISK allows you to mark the primary partition as active partition.
3. Delete Partition: You can delete a partition by using FDISK
4. Display Partition Information. 

FDISK can be used with MBR switch to replace the Master Boot Record with a backup copy. 

SCANDISK: ScanDisk is a utility program that was added to DOS Version 6.0. SCANDISK is a better 
compared to CHKDSK. SCANDISK can fix errors on data storage devices such as hard disks, floppy 
disks, RAM drives etc, and DoubleSpace compressed drives. It analyzes and repairs damage to the 
following:

1. Physical clusters

A+ Essentials Exam Sim              A+ Practical Exam Sim               Network+ Exam Sim              Security+ Exam Sim                Server+ Exam Sim

 Revision 1.0                                                                copyright © 2014 SimulationExams.com                                                                                 14

http://www.simulationexams.com/exam-details/server-plus.htm
http://www.simulationexams.com/exam-details/security-plus.htm
http://www.simulationexams.com/exam-details/network-plus.htm
http://www.simulationexams.com/exam-details/aplus-practical-application-220-802.htm
http://www.simulationexams.com/exam-details/aplus-essentials-220-801.htm
http://www.simulationexams.com/


2. File allocation table (FAT)
3. Lost clusters
4. Cross-linked files
5. Directory tree
6. MS-DOS Boot sector
7. DBLSPACE volume header, file structure, compression structure.

CHKDSK (Check Disk): CHKDSK command, one of DOS commands, examines your hard drive for 
error conditions and reports the total size of the disk, how many files are stored there, and the space 
remaining. CHKDSK also reports the total amount of conventional memory in your system and the 
amount of conventional memory available. Note that CHKDSK can't report extended memory.

DFRAG: The DFRAG.EXE is included with DOS6.0 and later. DEFRAG utility arranges the clusters of
data on the hard drive to achieve better performance by placing all of the clusters for a given file 
together in a contiguous order. DEFRAG does not do any repair on your disk, and errors, if any will 
remain on the disk.

BACKUP: DOS has a backup utility since version 2.0. 

The command "format a: /s" can be used to format the floppy disk in drive A, and at the same time 
make it bootable. 

To make floppy in drive A bootable, the command SYS A:  should be given.

IO.SYS
1. It does: Loads basics Input/ Output routines for the processor

2. Default Attributes: Hidden / System/ Read Only 3. Is it required for OS Start up: YES

MSDOS.SYS

1. It does: Defines System File locations

2. Default Attributes: Hidden / System/ Read Only

3. Is it required for OS Start up: YES

To stop a single process on a Windows 7 workstation from the command line

You have to run the Command Prompt as Administrator. To do this just right click command prompt 
from "All Programs > Accessories > Command Prompt" then select "Run as Administrator" on the pop-
up menu.

On the Command Prompt, perform the following.

1. Type "task list" and press enter. It will show you a list of all the running processes.
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2. Now you can End any particular process by executing the "Task kill" command. For Example, to kill 
Chrome just type.

Example:
Task kill /IM chrome.exe /F
Where:
/IM - Kill by Image Name
/F - Kill the process forcefully.

Of course, you can also do this using Task Manager without going to the command prompt.

You can have "Recovery Console" as a start up option by typing \i386\winnt32.exe /cmdcons at the 
command prompt, after switching to the CD ROM drive letter. To install the Recovery Console, follow 
these steps:

1. Insert the Windows XP CD into the CD-ROM drive.
2. Click Start, and then click Run.
3. In the Open box, type d:\i386\winnt32.exe /cmdcons where d is the drive letter for the CD-
ROM drive. In the case of 'Microsoft Windows XP Professional x64 Edition, type 
d:\amd64\winnt32.exe /cmdcons where d is the drive letter for the CD-ROM drive.
4. A Windows Setup Dialog Box appears. The Windows Setup Dialog Box describes the 
Recovery Console option. To confirm the installation, click Yes.
5. Restart the computer. The next time that you start your computer, "Microsoft Windows 
Recovery Console" appears on the startup menu.

1.4 Given a scenario, use appropriate operating system features and tools.

1. MSCONFIG, short for "Microsoft System Configuration Utility" is designed to help you troubleshoot
problems with your computer, MSCONFIG can also be used to ensure that your computer boots faster. 
Every time you boot your computer a lot of "hidden" programs load in the background. Some of these 
hidden programs are essential, but most aren't. Turning off some of these hidden programs (or services) 
can significantly increase your computer's performance and reliability. 

2. The Device Manager provides the status of the devices installed in the system. The Device Manager 
lists all the hardware devices installed on your system. You can also update any existing drivers, as well 
as change the hardware settings. You use Add/ Remove Hardware to install new hardware. Accessibility
options is primarily used to configure the keyboard, display, and mouse options on a computer to 
accommodate the users who are physically handicapped. The Add/ Remove Programs is used to install /
uninstall 3rd party software. This is also used for installing / uninstalling Windows 2000 optional 
components. To connect a USB device,

a. The computer supports USB.

b. The USB should be enabled in the BIOS,
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If both the above conditions are met, USB Controller is listed in the Device Manager. If it’s not listed in 
the Device Manager, you can suspect that the USB was not enabled in the BIOS. 

3. USB devices are hot pluggable. There is no need to reboot the computer. If the drive files for the USB
device is available already with the operating system, the system will automatically load the drivers for 
the device. Otherwise, the driver files need to be provided separately. 

4. You can access Computer Management screen through:

a. MyComputer on Desk Top -> Right Click -> Manage

b. Start -> Programs -> Administrative Tools -> Computer Management

One of the frequently used resource in “Computer Management” screen is System Tools. System tools 
contain the following:

a. Event Viewer
b. System Information
c. Performance logs
d. Device Manager
e. Shared folders
f. Local Users and Groups

These are very useful tools to a system administrator. 

5. You can access Task Manager by pressing <Alt> <Ctrl> <Del>. The applications tab lists all the 
applications that are currently running on the computer. The current status of the application is also 
displayed as either “Running” or “not responding” or “stopped”. 

6. You can enable memory dump to a file when your system is about to crash due to Stop Error (such as 
Blue Screen)The following types of memory dumps are available with Windows XP/2000:

a. Complete memory dump
b. Kernel memory dump
c. Small memory dump (64 KB) 

7. You can start the Files and Settings Transfer Wizard by clicking Start on the computer running 
Windows XP, pointing to All Programs, Accessories, System Tools, and then clicking Files and Settings 
Transfer Wizard. 

8. The System Preparation (Sysprep) tool prepares an installation of Windows® for duplication, 
auditing, and customer delivery. Duplication, also called imaging, enables you to capture a customized 
Windows image that you can reuse throughout an organization. Audit mode enables you to add 
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additional device drivers or applications to a Windows installation. After you install the additional 
drivers and applications, you can test the integrity of the Windows installation. Sysprep also enables you
to prepare an image to be delivered to a customer. When the customer boots Windows, Windows 
Welcome starts.

9. Windows Performance Monitor is a Microsoft Management Console (MMC) snap-in that combines 
the functionality of previous stand-alone tools including Performance Logs and Alerts, Server 
Performance Advisor, and System Monitor. It provides a graphical interface for customizing Data 
Collector Sets and Event Trace Sessions. Windows Performance Monitor enables you to track the 
performance impact of applications and services, and to generate alerts or take action when user-defined
thresholds for optimum performance are exceeded.

10. Always Notify option in User Account Control, which is the selection at the top of the slider and is 
identical to the default mode in Windows Vista. It will show the user any changes to the computer either
by a program or the user themselves. Although the default mode would notify for programs that wanted 
to change the computer settings, it would not notify if the users accidentally changed something. 

11. Sync Center allows you to check the results of your recent sync activity if you’ve set up your 
computer to sync files with a network server (often called offline files). When you sync with a network 
server, you can access files by keeping synced copies of those files on your computer, even when the 
network server is unavailable. Sync Center can tell you if the files synced successfully or if there are 
any sync errors or warnings. To launch sync center, just open your control panel, then click sync center.

1.5 Given a scenario, use Control Panel utilities (the items are organized by “classic view/large 
icons” in Windows)

1. To change the account lockout threshold to 15 minutes on Windows 7 computer

a Open the Control Panel (icons view), and click on the Administrative Tools icon.

I. Close the Control Panel window.

II. Double click on Local Security Policy to open it.

b. You can now set and manage the Local Security Policies on your computer to how you want them.

Alternatively,

To Open Local Security Policy Editor through Local Group Policy Editor

a. Open the Local Group Policy Editor.

b. Under Computer Configuration and User Configuration, click on and expand Windows 
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Settings to see the Security Settings.

c. You can now set and manage the Local Security Policies on your computer to how you want 
them. (See screenshot above)

Alternatively,

a. Open the Start menu, and type secpol.msc in the search line and press Enter.

NOTE: This file is located at C:\Windows\System32\secpol.msc.

2. Event Viewer maintains logs about program, security, and system events. You can use Event Viewer 
to view and manage the event logs, gather information about hardware and software problems, and 
monitor Windows 2000 security events.

To open Event Viewer, click 'Start', point to 'Settings', and then click 'Control Panel'. Double-click 
'Administrative Tools', and then double-click Event Viewer. 

3. Event Log Explorer helps you to quickly browse, find and report on problems, security warnings and 
all other events that are generated within Windows. Monitoring and analysis of events recorded in 
Security, System, Application and other logs of Microsoft Windows NT/2000/XP/2003 operating 
systems can be useful in identifying and diagnosing problems.

4. Microsoft Windows XP automatic update feature enables a user to stay current with the latest updates
for their computer. You can enable or disable automatic updates by going to "automatic updates" tab of 
System applet of Control Panel. 

5. Microsoft Windows XP comes pre-installed with a software firewall utility although by default this 
feature is not enabled.
Enabling the Windows XP firewall:

a. Click Start, Settings, Control Panel and open Network Connections.
b. Within the Network Connections window right click the Local Area Connection and select 
properties.
c. Within the Local Area Connection Properties window click the Advanced tab.
d. Finally, check the Protect my computer and network by limiting or preventing access to this 
computer from the Internet option. 

6. The default spool folder is located at: Systemroot\System32\spool\printers. For example, if the OS is 
residing on C drive, the default location will be: “C:\\WINNT\System32\spool\printers”.
You can access this location through:
Start -> Printers -> File -> Server Properties -> Advanced tab. Type in the new spool location over the 
default location. 

7. You can use Add/ Remove applet in the Control Panel to add or remove a program. 
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1.6 Setup and configure Windows networking on a client/desktop

1. For accessing the Internet using static IP addressing, you need to configure the IP address, subnet 
mask, default gateway (if required by the ISP), and DNS server information. 

2. IPCONFIG gives the current IP address assigned to the  computer. 

3. The default subnet masks for various classes of IP address are given below:

Class A: 255.0.0.0
Class B: 255.255.0.0
Class C: 255.255.255.0 

4.You can ping the loop back address at 127.0.0.1. A response ensures that the TCP/IP stact is installed 
properly on your computer. 

5. You can use both Ping Localhost and Ping 127.0.0.1 to see whether the TCP/IP stack is installed 
properly. Ipconfig is used to obtain the TCP/IP configuration information, such as the IP address, subnet
mask, default gateway etc. on the local computer. 

6. Remote Desktop Connection (RDC, also called Remote Desktop, formerly known as Microsoft 
Terminal Services Client, or mstsc) is the client application for Remote Desktop Services. It allows a 
user to remotely log in to a networked computer running the terminal services server. RDC presents the 
desktop interface (or application GUI) of the remote system, as if it was accessed locally.

1.7 Perform preventive maintenance procedures using appropriate tools

1. To schedule Automatic Updates on Windows XP:

1. Click Start, click Control Panel, and then double-click System.
2. On the Automatic Updates tab, click Automatically download the updates, and install them on 
the schedule that I specify.
3. Click to select the day and time that you want to download and install updates.

2. In Windows 2000, to configure Automatic Updates, do the following:

1. Click Start, click Control Panel, and then double-click Automatic Updates.
2. Click Automatically download the updates, and install them on the schedule that I specify.
3. Click to select the day and time that you want to download and install updates. 

1.8 Explain the differences among basic OS security settings
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2. Microsoft Internet Explorer and Windows Explorer can be used for assigning Share and NTFS 
permissions on a Windows 2000 computer. 

2. On a stand-alone computer or a computer that is a member of a workgroup, a user account establishes
the privileges assigned to each user. The three user accounts available are: Administrator, Limited, and 
Guest. The important features of these accounts are as given below:

3. Administrator account:

- Can create and delete user accounts on the computer.
- Can change other users' account names, passwords, and account types.

4. Limited account:

- Generally cannot install software or hardware, but can access programs that have already been 
installed on the computer.
- Can create, change, or delete his or her password.
- Cannot change his or her account name or account type. A user with a computer administrator 
account must make these kinds of changes.
- Can manage his or her network passwords, create a reset password disk, and set up his or her 
account to use a .NET Passport.

5. Guest account:

- Cannot install software or hardware, but can access applications that have already been 
installed on the computer.
- Cannot change the guest account type. 

6. Standard user account 

- lets a person use most of the capabilities of the computer, but permission from an administrator
is required if you want to make changes that affect other users or the security of the computer.

- When you use a standard account, you can use most programs that are installed on the 
computer, but you can't install or uninstall software and hardware, delete files that are required 
for the computer to work, or change settings on the computer that affect other users.

- If you're using a standard account, some programs might require you to provide an 
administrator password before you can perform certain tasks.

7. Windows Vista Home Basic, Vista Home Premium, and Vista Starter provide only limited support for
EFS (Encrypted File System), whereas Vista Business, and Vista Ultimate provide full support for EFS.
Upgrade to Windows Vista Ultimate. You can upgrade to Windows Vista Ultimate from Windows XP 
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Home, XP Professional, XP Media Center, and XP Tablet PC, Windows 2000 Professional can't be 
upgraded to Windows Vista directly.

1.9 Explain the basics of client-side visualization

Virtualization has become very popular because of its main two advantages the performance and cost 
saving. Virtualization can be implemented through open source like Xen and VirtualBox as well as 
proprietary solutions like VMware. It allows you to make one physical device appear as a number of 
standalone entities to users. A virtual desktop is often referred as VDI(Virtual Desktop Interface) it 
refers to software and hardware needed to create virtual environment. Microsoft Virtual PC 2007 is 
available for Windows XP and Vista and Windows Virtual PC is available for Windows 7.

Purpose of Virtual Machines

A workstation can have multiple operating systems installed on it but can run only one OS at a time but 
by running virtualization software same workstation can run Windows server along with windows 7 and
Linux or any other operating system at the same time. This will allow a developer to test a code on 
various environments at the same time and he can also move code from one operating system to another
with basic copy paste.
Each virtual desktop will typically need full network access. Configuring permissions for each virtual 
desktop can be tricky for administrator. Remote administration often uses virtual desktop to work on a 
workstation without knowledge of user sitting on the workstation.

Resource requirements

The hardware on the machine must have enough memory, hard drive space and processor capability to 
support virtualization. Also software is needed to make virtualization possible these requirements are 
based on the type of environment you are creating.

Emulator requirements

Window XP has a free emulator from Microsoft that you can download and use as a virtual emulator. In 
most cases, the motherboard and associated BIOS settings need no alteration to provide service to these 
virtual machines. Some of the newer virtualization products like Microsoft’s Hyper-V and Windows 7 
Virtual PC require that the motherboard support hardware-assisted virtualization. The advantage of 
using hardware-assisted virtualization is it allows the Hypervisor (the virtualization product) to 
dynamically allocate memory and CPU to virtual machines as required.

Security Requirements

Security for virtualization is important because if somebody gains access to the host, they effectively 
would gain access to at least parts of all those different operating systems. And if you have a failure of 
the hardware of that host, then of course all of those other operating systems are not going to work 
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either.
Main security threat in virtualization is to the hypervisor. The VM escaping is a new type of security 
concern. Because if you can gain access to those virtual machines and then even gain access from one 
virtual machine to the other through the hypervisor, that’s a significant security hole. The bad guys are 
trying to create malware and find ways to get around and move around that operating system or multiple
operating systems much easier than what they can do today. If they can take advantage of the 
hypervisor, that gives them a very, very useful channel. Both physical and digital security methods are 
used to ensure security in virtualization

Network Requirements

While it is possible to do desktop virtualization on a computer without an internet connection there are 
several reasons for which having internet connection is an advantage. First hypervisors can be obtained 
from internet, and updates to hypervisors, host operating system, guest operating system are easily 
available on internet. Furthermore, if you create a virtual machine to test an operating system or other 
software for use in a normal environment, then you certainly should include testing how it works on a 
network. Therefore, the hypervisors we use simulate a network card within each virtual machine, as 
well as a network on the host, so that multiple virtual machines can communicate with each other and 
the underlying host. Then, through a virtual connection to the host computer’s physical network adapter,
each VM has access to an external network, and through that to the Internet, if available. Of course, you
can turn off these and other features for a VM, if you desire.

Hypervisor

To do desktop or server virtualization, you first need a hypervisor. A hypervisor, also called a virtual 
machine monitor (VMM), is the software that creates a virtual machine, providing access to the 
necessary hardware on the host machine in isolation from other virtual machines and the host operating 
system, if present. This allows multiple operating systems to run simultaneously on a single physical 
computer, such as a network server or desktop computer. A hypervisor must create a virtual CPU 
compatible with that of the underlying machine—mainly either an Intel or an AMD CPU. This means 
that the installed OS must be capable of installing directly on the underlying computer. Also, today’s 
hypervisors require, or at least work best on, computers with Hardware-Assisted Virtualization (HAV) 
features, either Intel Virtualization Technology for x86 (Intel VT-x) or AMD Virtualization (AMD-V). 
HAV supports and improves the performance of virtual machines on the host. Both Intel and AMD 
CPUs have supported HAV since 2006.

2. Security

2.1 Apply and use common prevention methods

1. Each Virtual Machine is like a separate platform, and the host PC is transparent to the end user. If the 
VM is infected with virus the end user may treat the virus same as in a normal PC. There is no need to 
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shut down the host operating system.

2.2 Compare and contrast common security threats

1. Software is considered malware (malicious software) based on how the software is intended to be 
used. Malware includes computer viruses, worms, Trojan horses, spyware, dishonest adware, and other 
malicious and unwanted software

a. A boot sector virus stays resident by infecting the boot sector of the computer

b. A Master boot record (MBR) virus infect the first physical sector of all affected disks

c. File viruses either replace or attach themselves to executable files, and most commonly found 
virus.

d. Macro virus attaches itself to documents in the form of macros.

e. Memory viruses are viruses that execute and stay resident in memory. Trojan Horse is an 
example of memory virus. A Trojan is not a virus. The principal variation between a Trojan 
horse, or Trojan, and a virus is that Trojans don’t spread themselves. Trojan horses disguise 
themselves as valuable and useful software available for download on the internet. Trojan may 
work as a client software on your computer communicating with the Trojan server over the 
Internet.

f. A browser hijacker is a form of malware, spyware or virus that replaces the existing internet 
browser home page, error page, or search page with its own.[1] These are generally used to force
hits to a particular website.

2. Anti-virus update files are traditionally called as “Definitions”.

3. Possible reasons for slow running of a computer may include insufficient memory, viruses and Trojan
horses, too many TSRs (Terminate and Stay Resident) running at the same time, etc. Ensure that your 
computer has sufficient memory, hard disk space, and anti-virus software installed (particularly if 
connected to the Internet).

2.3 Implement security best practices to secure a workstation

1. Encrypting File System (EFS) keeps your documents safe from intruders who might gain 
unauthorized physical access to your sensitive stored data by stealing your laptop or Zip disk, or by 
other means. 

2. Anti-virus software, and Spyware software can be used to clear malicious programs from a computer. 
Also, note that you need to install up-to-date Service Packs, and patches.
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3. Never store passwords in plain text files.

4. Never write down the username and passwords on a paper if done so destroy it after memorizing it.

2.4 Given a scenario, use the appropriate data destruction/disposal method

1. Batteries contain environmentally hazardous chemicals and therefore, should not be disposed through
dust bit. Always refer to the manufacturer's instructions or the relevant State guidelines. The same is 
true when you are disposing chemical solvents. 

2. MSDS stands for Material Safety Data Sheet. It is US state department document that contain 
information on any substance that is hazardous, and proper use / disposal. 

3. Nickel Cadmium battery is not environmentally friendly and not as efficient as Nickel/Metal hydride 
or Lithium Ion. Nickel/Metal hydride, though environmentally friendly, not as efficient as Lithium Ion. 
Lithium Ion battery is environmentally friendly and very efficient. 

4. To get rid of the old computers proper options are:

a. Donate to a charity
b. Recycle it by giving it to a recycle center
c. Give it to a training school in the neighborhood

2.5 Given a scenario, secure a SOHO wireless network

1. MAC limiting the MAC addresses that can access the wireless network, you can prevent 
unauthorized computers from accessing your wireless network. Note that each MAC address is unique, 
and hence MAC address filtering can effectively prevent unauthorized computer access. 

2. MAC Filtering (or layer 2 address filtering) refers to a security access control method whereby the 
48-bit address (also called MAC address) assigned to each network card is used to determine access to 
the network. MAC addresses are uniquely assigned to each card, so using MAC filtering on a network 
permits and denies network access to specific devices through the use of blacklists and whitelists.

3. WEP, short for Wireless Equivalent Protection, is a security protocol designed to provide protection 
equivalent to wired LANs. WPA is an improved security protocol compared to WEP.

4. Wi-Fi Protected Access (WPA) and Wi-Fi Protected Access II (WPA2) are two security protocols and 
security certification programs developed by the Wi-Fi Alliance to secure wireless computer networks.
Enabling SSID broadcast will only annount the network to neighborhood devices, thus lessening the 
security of the network.
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2.6 Given a scenario, secure a SOHO wired network

1. If a networked computer is infected with zero day viruses then Traditionally, antivirus software relies 
upon signatures to identify malware. This can be very effective, but cannot defend against malware 
unless samples have already been obtained, signatures generated and updates distributed to users. 
Because of this, signature-based approaches are not effective against zero-day viruses.

2. A zero-day (or zero-hour or day zero) attack or threat is an attack that exploits a previously unknown 
vulnerability in a computer application, meaning that the attack occurs on "day zero" of awareness of 
the vulnerability.This means that the developers have had zero days to address and patch the 
vulnerability.

3. Mobile Devices

3.1 Explain the basic features of mobile operating systems

1. Advanced Configuration and Power Interface (ACPI) specification provides an open standard for 
device configuration and power management by the operating system.

2. The specification is central to Operating System-directed configuration and Power Management 
(OSPM), a system implementing ACPI, which removes device management responsibilities from legacy
firmware interfaces.

3. The Advanced Host Controller Interface (AHCI) is a technical standard defined by Intel that specifies
the operation of Serial ATA (SATA) host bus adapters in a non-implementation-specific manner.

5. iOS 5 offers untethered updates.

6. You can see the IP address of an iOS device by going to Settings > General > Network > Wi-Fi > 
SSID Name > IP address

7. iTunes is a media player and media library application developed by Apple Inc. It is used to play, 
download, and organize digital audio and video on personal computers running the OS X operating 
system and the iOS-based iPod, iPhone, and iPad devices, with editions also released for Microsoft 
Windows.

8. iCloud is a cloud storage and cloud computing service from Apple Inc. The service allows users to 
store data such as music and iOS applications on remote computer servers for download to multiple 
devices such as iOS-based devices running iOS 5 or later, and personal computers running OS X 10.7.2 
"Lion" or later, or Microsoft Windows (Windows Vista service pack 2 or later). 

9. Gyroscope enables re-alignment of screen orientation as the user turns his phone.
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10. The Global Positioning System (GPS) is a space-based satellite navigation system that provides 
location and time information in all weather conditions, anywhere on or near the Earth where there is an
unobstructed line of sight to four or more GPS satellites. Most smart phones have GPS built in to the 
software.

3.2 Establish basic network connectivity and configure email

1. Bluetooth is widely used for communication between smart phones and other accessories or between 
PDAs and information kiosks. The typical coverage for Bluetooth devices is up to 30 feet.Bluetooth 
devices, when in discoverable mode, are able to be seen ( discovered ) by other bluetooth devices. If 
two phones connect, the phone that is trying to establish the initial connection, must be looking for a 
phone that is "discoverable" otherwise it will not see it. Once the connection is saved, discoverable 
mode is no longer necessary, as the phones already know each other. This is only necessary during an 
initial link.

2. The Wireless function key typically turns on / off the wireless radio. If you inadvertantly press the 
function key, it is possible that you are not able to access the Internet, if using WiFi.

3. You need to know your domain name (e.g. example.com.au), email address (e.g. 
yourname@example.com.au) and email account password. You also need to know the POP or IMAP 
server name.

3.3 Compare and contrast methods for securing mobile devices

1. A cable lock is the most inexpensive solution to secure a laptop from theft. A cable lock just works 
the same way a bicycle lock works. It physically secures the laptop to a table or any other solid object 
that cannot be moved easily.

2. Setting passcodes on mobile devices is the most basic security requirement for any mobile device to 
be allowed into a work environment. Passcodes require the user to enter a passphrase to unlock the 
device. Devices can also be configured to lock automatically after a configurable timeout period. 
(Typically, five minutes is ideal.)

3. Privacy screen or a privacy  guard protects the sensitive information on your screen while also 
protecting the screen itself from scratches and damage. It is useful when travelling or in public place in 
preventing prying eyes from seeing what´s on your laptop screen. And it´s thin enough that it still 
allows your laptop to close and latch.

 4. A remote wipe removes all device-based data like mail, calendar, and contacts from the device, but it 
may not delete data stored on the device's SD card. Use this feature when a device is lost or stolen to 
erase all data on the device and reset the device.
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3.4 Compare and contrast hardware differences in regards to tablets and laptops

1. LCD screens require a backlight system to operate, there are two backlight systems in use today 

a. CCFL - Cold Cathode Fluorescent Light, is an older backlight method, which utilizes a 
daylight specter fluorescent tube and an inverter which powers it.

b. LED - is a backlighting system which does not use an inverter, and instead of a fluorescent 
tube it uses a strip of LEDs (Light Emitting Diodes).

So in essence there two types of laptop screens: LCD-CCFL and LCD-LED: these screens are NOT 
INTERCHANGEABLE.

2. OLEDs do not require backlighting like LCDs. LCDs work by selectively blocking areas of the 
backlight to make the images that you see, while OLEDs generate light themselves. Because OLEDs do
not require backlighting, they consume much less power than LCDs

3. Note that the external display is working properly and the problem is only with the internal laptop 
display. The most likely problem is with the inverter which powers the LCD display. Some times, an 
outline of an image can be viewed on a laptop screen, but it is very dim and the screen appears almost 
black. Such problems are almost always due to bad inverter and LCD.

4. Accelerometer measures acceleration (change of velocity) in a given direction. Mobile devices use 
accelerometer for screen orientation. Every modern Smartphone can change the orientation of the 
display based on the phone's rotation thanks to its accelerometer. Traditional accelerometers use a 
"seismic mass" attached to a spring encased in some sort of housing. As the device moves the mass 
moves on the spring and the device can measure the movement. Using multiple units a device can 
determine which way it turned based on which masses move.

5. Tablets normally use solid state drives. SSDs are rugged and occupy less space.

3.5 Execute and configure mobile device synchronization

1. If a user wishes to access his contact from his Android phone. Enable contact sync by setting up his 
email  account on the phone to  provide the most up to date contact information on the user's phone on a
daily basis.

4. Troubleshooting

4.1 Given a scenario, explain the troubleshooting theory
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1. For effective communication, you need to spend roughly 50 percent of time for listening to your 
customer 

2. The customer was obviously concerned when he reported the matter to you. Appropriate action would
be to apologize to the customer, and assure him that it would not happen again. You need to report this 
to the manager, so that necessary action is taken to educate the technician that misused the office time. 

3. The customer would be expecting you at the specified time. It is appropriate to call the customer over
phone, and inform him that you would be late. Sending an email may not be the best option, since the 
customer may not see his/her email often. Your colleague may not convey the message to your customer
appropriately. 
4. When attending to the computer maintenance or repair (other than the monitor), ensure that you work
in a static free environment. Always wear wrist strap. You should not wear clothes/shoes that produce 
static charges. 

5. When working on computers, use special ESD wrist strap. Do not directly ground yourself with a 
piece of wire. An ESD wrist strap has built-in resistor to prevent electric shock. Use specially designed 
grounded ESD mats. Do not wear synthetic clothing. Place all electronic components into anti static 
bags. Anti static bags can be reused. Keep your workplace clean. 

6. While doing any hardware up gradation on a laptop (such as adding more memory, etc), remember to 
remove the battery in addition to unplugging of AC mains. 

7. You need to take the customer in to confidence, and apologize to him/her for having lost some 
important files/folders. 

8. You should not give away your login information to anybody over email. Usually, such emails are not
genuine, and intended for malicious use. 

4.2 Given a scenario, troubleshoot common problems related to motherboards, RAM, CPU and 
power with appropriate tools

1. On a personal computer, the general errors and the corresponding failures are shown below:

100-199 : System board failures
200-299 : Memory failures
300-399 : Key board failures
400-499 : Monochrome video problems
500-599 : Color video problems
600-699 : Floppy disk errors
1700-1799: Hard disk problems. 

2. Some of the frequently encountered error codes and their corresponding error messages on a PC are 
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given below:

Error Code----Error Message
161 - CMOS battery failure: Replace the CMOS battery
164 - Memory size error : If the error occurs after memory upgrade, run SETUP program.
201 - Memory test failed : RAM chips failed, one or more may need to be replace.
301 - Keyboard error: You may have to check the key board 

3. The IRQ numbers and relevant Standard Device Assignment are given below. It is important to 
memorize these values before going to the exam, as there would be 5-10 questions on IRQs, and 
conflicts.

IRQ----Standard Device Assignment
0-System timer
1-Keyboard
2-Cascade to IRQ9. Can't be used.
3-COM ports 2 and 4
4-COM ports 1 and 3
5-Parallel Port LPT2. Very often used for sound cards.
6-Floppy drive controller
7-Parallel Port, LPT1
8-Real time clock
9-Unassigned (Also redirected from IRQ2)
10-Available
11-Available. SCSI adapter will usually use this IRQ.
12-Mouse or touch pads
13-Math co-processor.
14-Primary hard-disk IDE controller
15-Secondary hard-disk IDE controller. 

4. A toner probe is an electronic test instrument to help trace wires. One part (the tone generator) 
induces a tone on a pair of wires, and with the other you part (the tone probe) you can detect the tone at 
the other end to trace where the wires go. You can trace wires through walls using a tone probe, and 
determine which pair is carrying the signal you induced at the other end.

5. A cable tester is used to verify that all of the intended connections exist and that there are no 
unintended connections in the cable being tested. When an intended connection is missing it is said to 
be "open". When an unintended connection exists it is said to be a "short" (as in short circuit). If a 
connection "goes to the wrong place" it is said to be "miswired" (the connection has two faults: it is 
open to the correct contact and shorted to an incorrect contact).

6. The main difference between a cable tester and a toner probe is that in the former, you have access to 
the both ends of the cable at the same time, and you normally to Open or Short testing (to determine 
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right pins are connected), and in the latter, you dont have simultaneous physical access to both ends of 
the cable. 
An AT computer will have two interrupt controllers. The second interrupt controller needs to deliver the 
interrupts through the primary interrupt controller. IRQ2 had been identified for this purpose on the 
primary and IRQ9 on the secondary interrupt controllers. In other words, IRQ2 and IRQ9 are cascaded. 

7. AT style systems use two power connectors, P8 and P9 to connect to the motherboard. ATX systems 
use only one P1 connector to connect to the motherboard.

8. If you are getting a keyboard error, you need to do one of the following things:

a. Check if the keyboard needs to be cleaned
b. Check if the keyboard cable has become loose
c. Check if one or more of the keys are stuck
d. If required, replace the keyboard. 

9. The battery is supposed to provide backup in the event of any power failure, typically up to 2 hours 
or more. 

10. The best ways to find whether a new hardware is supported by your Windows OS is to check the 
manufacturer’s documentation first, and then the Hardware Compatibility List (HCL). 

11. The inverter board is responsible for converting low voltage DC power to high voltage AC, 
necessary to light up the back-light bulb. If the inverter board is bad, the LCD screen (back-light bulb) 
will not light up when you turn on the laptop, but you still should be able to see a very dim image on the
screen. 

12. The most likely cause for excessive paging is insufficient Memory. Increase the physical Memory 
on your computer.

13. Date and Time Not Set is the most common error that occurs when the BIOS battery is drained. You 
need to replace the CMOS battery.

14. The most likely cause for sporadic movement of mouse is dirt. If dirt has entered the mouse, clean 
the dirt with IPA, or cotton wetted in soap water. 

15. The most likely problem is conflicting IRQs. Since the mouse is working until the modem is used, 
the IRQ/IO address of modem may be conflicting with that of the mouse.

16. The motherboard displayed has the following expansion slots:

a. PCI slots : 5 (distinguished by white color, usually the number of PCI slots available on a 
motherboard varies from 3 to 6)

b. ISA slots: 2 (distinguished by black color, longer than PCI slots, placed next to PCI slots.)
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c. AGP slot: 1 ( The single slot, next to 5 white PCI slots is AGP slot in brown color. Note that 
there will be only one AGP slot) 

17. To obtain BIOS string ID:

a. Power off the system
b. Either unplug your keyboard or hold down one of the keys on the keyboard
c. Power-on the system and you should get a keyboard error
d. The string in the lower left hand corner of your computer screen represents the BIOS String 
ID.

18. It is also possible to read the BIOS information by going to the BIOS set-up of the PC by pressing 
appropriate key (usually Del key) during boot up. 

19.Various POST (Power On Self Test) error codes and their description is as below:

Code 01: Undetermined problem
Code 02: Power Supply error
Code 1xx: System board errors
Code 2xx: Memory (RAM) errors
Code 3xx: Keyboard errors
Code 6xx: Diskette Drive errors
x is any single digit integer. 

20. The following are true about backup:

a. Full backup: Here all files that have been chosen for backup are backed up, irrespective of 
whether the archive bit is set or not set. Archive bit is set (ON) after backup.

b. Incremental backup: Here only the files that have been created or have changed since the 
previous full or incremental backup will be backed up. The archive bit is set after a file is backed
up.

c. Incremental backup will backup files that have changed since previous full or incremental 
backup.

d. Differential backup: Here, the files that have changed or created since the last full backup will
be backed up. Note that, unlike Incremental backup, the archive bit is not set on a differential 
backup. The result of this is that the next differential backup will include files that were backed 
up during earlier Differential backups.

21. UPS usually contains a filter to smoothen the noise, and this filter is called noise filter.

4.3 Given a scenario, troubleshoot hard drives and RAID arrays with appropriate tools

1. If the CMOS setup is not properly setup the computer may ignore or not look at the CD-ROM as a 
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bootable option. Verify in the CMOS that your settings are properly set to boot from the CD-ROM 
drive.

2. The Complementary Metal-Oxide Semiconductor (CMOS) allows the computer to store the Real 
Time Clock (RTC)and other device information even after the computer is switched off and on. This is 
achieved by using a battery just for CMOS.

3. Generally, these settings will be under the boot options. Setup your boot options similar to the below 
example.

1 - Floppy / LS120
2 - CD-ROM
3 - Network (if available)
4 - Hard Disk Drive

4. If CD-ROM is listed after a device that is bootable it will boot from the other device before the CD-
ROM. Verify that the devices before CD-ROM, such as floppy, do not have bootable media in them. 

5. If the SCSI bus termination is not done, SCSI devices on the bus will not function properly. This is 
due to reflection of the signals at the end of the bus. To prevent this, both ends of the SCSI bus needs to 
be terminated. If one end of the SCSI bus is terminated, you may find intermittent problems. Never 
terminate the bus at a device connected in between. 

6. If you are creating a Striped volume on a new Windows 2000 machine, it can only be created on 
dynamic disks. However, if you are upgrading a Windows NT computer to Windows 2000, any existing 
stripe set will be supported. 

7. If you are finding that the Logical Disk > %Free Space counter is less than 10%, you might need to 
make additional free space available. This can first be done cleaning up the disk of any unwanted files, 
duplicate files etc. If required, additional physical disk may be provided.

8. Some of the important System Monitor counters are:

a. Memory>Available Mbytes: measures the amount of physical memory that is available. 
Typically > 4MB. If less than 4 MB, consider adding more memory.

b. Memory>Pages/Sec: Shows the number of times that the disk has been accessed, because 
requested information was not available in memory. If the value of the counter is not below 20, 
you should add more memory. A value of 4 or 5 is typical.

c. Paging File>%Usage: Indicates the % of allocated page file utilization. Should be less than 
99%.
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d. Processor>%Processor Time: measure the time that the processor is busy. Should be typically 
less than 80%

e. Processor>Interrupts/Sec: Indicates the average number of hardware interrupts that the 
processor receives each second. If more than 3,500, you can suspect a program or faulty 
hardware.

f. PhysicalDisk>%Disk Time: Measures the amount of time that the physical disk is busy 
servicing read or write requests. If more than 90%, you can improve the performance by adding 
another disk channel.

g. PhysicalDisk>%Current Disk Queue Length: indicates the number of pending disk requests 
that need to be processed. The value should be less than 2. The disk problems might arise from 
less memory, resulting in usage of excessive paging. Ensure that the memory is sufficient before 
attending to the disk problem.

8. LogicalDisk > %Free Space counter: Indicates the amount of logical disk’s free disk space. 
Typical value is 10% or above. 

9. If you have a standard desktop PC that uses integrated drive electronics (IDE) disk drives, then these 
will be detected during setup. If, however, you use SCSI disks or have Redundant Array of Independent 
Disk (RAID) storage systems, you will see, shortly after the reboot, the following line of text displayed 
at the bottom of the screen:

10. “Press F6 if you need to install a third party SCSI or RAID driver...” Pressing F6 will start a dialog 
that allows you to configure and install the drivers for your SCSI or other disk subsystem controllers. 
This option is usually used on server platforms that use large-capacity, high-speed, fault-tolerant disk 
subsystems. For most PCs, however, you won't need to use this option. 

11. If you want to format a drive and also make it bootable, you need to format with /s switch. By 
issuing this command, the boot files IO.SYS, MSDOS.SYS, COMMAND.COM get copied to the disk. 

12. Important RAID (Redundant Array of Inexpensive Disks) details are given below:

a. RAID 0: This has striping but no redundancy of data. It offers the best performance but no 
fault-tolerance.

b. RAID 1: This is also known as disk mirroring. It consists of two or more drives that duplicate 
the storage of data. There is no striping. Read performance is better since either disk can be read 
at the same time.

c. RAID 2: It uses disk striping across disks with some disks storing error checking and 
correcting (ECC) information. RAID 2 is hardly used because it is expensive and does not 
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provide fault tolerance like other forms of RAID levels.

d. RAID 3: It uses disk striping and dedicates one drive to storing parity information. The 
embedded error checking (ECC) information is used to detect errors.

e. RAID 4: Block-level striping with dedicated parity. RAID-4 offers no advantage over RAID 3

f. RAID 5: Uses block-level striping with distributed parity. Thus, all read and write operations 
can be overlapped. RAID-5 stores parity information but not redundant data (but parity 
information can be used to reconstruct data). RAID 5 requires at least three disks for the array. 
It's suitable for multi-user systems in which performance is not critical. 

13. It is obvious that you can get shock is due to sudden discharge of static electricity. Since the 
operator is touching the memory module when the discharge happened, it is most likely that the 
memory module may have internally damaged. This damage may or may not show up immediately. In 
any case, it always recommended to replace the statically damaged module with a good one. Follow 
anti-static precautions before touching any electronic components inside a PC. 

14. It is recommended that the backup tape is stored at a location away from the building where the 
backup was taken. For most companies, backups contain important data and loosing backups may affect
the continuity of one’s business. If a backup is stored in the same building, it may get damaged in fire or
any other natural calamities along with the computers. As a result, both the server, as well as back fail at
the same time. Therefore, it is recommended to store the backup at a different location. 

15. If the hard-disk is making sound, the most likely problem is that the hard disk read/write head is 
scratching the disk surface. It often results in the total failure of the disk. If you find that you can still 
read/write to the disk, backup the hard disk and replace immediately. 

16. Low level formatting will erase the data on a hard drive permanently.

17. A hard disk should never be low level formatted at the customer premises. It is highly recommended
that it is done at the manufacturer's or at any authorized center.
It is very cumbersome to change the partition sizes, once the hard disk is partitioned and used. It may 
require backing up all the data and restoring after repartitioning.

4.4 Given a scenario, troubleshoot common video and display issues

1. Monitors accumulate very high static charges and need to be handled very carefully. Before 
attempting any repair, it is imperative to discharge any accumulated charges on the monitor. You can use
a jumper, one end of which is grounded, and touch the other end of the jumper wire to the anode of the 
monitor. While doing so, ensure that you are not in direct contact with the jumper wire or the anode. 
You can use a screw driver or a nose pliers with rubber handle for this purpose. A "POP" sound can be 
heard when the static charges accumulated on the anode lead getting grounded through the jumper wire.
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Remember, that if you get in contact with the static charge, it may lead to severe burns or even fatal 
accident! 

2. Never wear a wrist strap when working on monitors. Monitors contain very high voltages, sometimes
fatal to human, even when the power is turned off. If you are wearing wrist strap, the human body work 
as a conduit to discharge the electric charge. 

3. When you are installing a different SVGA monitor, it is unlikely that the new monitor has the same 
capabilities as the old one. As a result, the image on the screen may not be readable. In such instances, 
change the video resolution to Standard VGA before installing the new monitor. You can change the 
resolution appropriately after the image on the screen is readable with the new monitor. It may also be 
necessary to load appropriate device driver, if you are installing a different display adapter. 

4. The most probable cause that the screen is dumping garbled characters is that the communication 
settings are not correct. Check the speed, parity, start/stop bits etc. If the serial port parameters are 
correct, then you need to check the cable, such as straight/cross cable and the pin connections. 

5. The problems such as video card, network card, and modem card can be resolved by booting to Safe 
Mode. While in Safe Mode, troubleshoot the problem. 

4.5 Given a scenario, troubleshoot wired and wireless networks with appropriate tools

1. You need to memorize the following port addresses before attending the exam.

Port-Base address (in hex)
COM4: 2E8-2EF
COM2: 2F8-2FF
COM3: 3E8-3EF
COM1: 3F8-3FF
LPT2 : 278-27F
LPT1 : 378-37F

Floppy Controller: 3F0-3F7
Hard Drive Controller, 16 bit, ISA: 1F0-1F8 

2. If Microsoft Windows Firewall is blocking a port that is used by a service or by a program, you can 
configure the Windows Firewall to create an exception. Windows Firewall may be blocking a program 
or a service if the following conditions are true:

· Programs do not respond to a client's request.
· Client programs do not receive data from the server. 
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3. NBTSTAT This utility displays current NetBIOS over TCP/IP connections, and display NetBIOS 
name cache.

4. NETSTAT Displays protocol statistics and current TCP/IP connections since the server was last 
booted.

5. TRACERT Used to determine which route a packet takes to reach its destination from source.

6. IPCONFIG Used to display Windows IP configuration information.

7. NSLOOKUP This utility enables users to interact with a DNS server and display resource records.
ROUTE Used to display and edit static routing tables. 

8. Network is not configured with WINS server. WINS server resolves the NetBIOS names to IP 
addresses. The network need to be configured with WINS (or LMHOSTS file on each computer) for 
NetBIOS name resolution. 

9. If all the nodes on the network have been disconnected still if the switch port is blinking rapids even 
in the absence of any data, it is very likely that the switch port or the switch is bad. 

10. Running a command like “ping” or “ipconfig” will open the command screen. However, the 
command screen closes soon after the execution of the command. If you intend to observe the results of 
any such command, you need to open the DOS screen by going to Program Files | Accessories | 
Command Prompt. 

11. When doing over the network installation, the most likely causes for failure are:

a. The domain controller may not be up and running. You need to ensure that the domain 
controller is running.
b. The username and password may not be correct. You need to have appropriate access rights to
join a domain. Ensure that you have appropriate access rights and that you have typed in correct 
username and password. Note that the passwords are case sensitive in Windows 2000. 

12.Some of the important commands useful in trouble shooting TCP/IP networks are:

I. Ipconfig: Displays TCP/IP configuration values, including IP address, subnet mask, and 
default gateway.

II. Ping: This command can be used to verify whether the target ip address or host name is 
present. You need to specify the target IP address or host name.

III. route: Displays and manipulates route information.
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IV: Tracert: Determines the route packets take to reach the specified destination.

13. The most important thing to do when a network card is replaced is to update the NIC driver. Without
this, the network card may not work. The NIC speed is limited by the peer device. If it is connected to a 
1Gbps switch port, then it will transmit at rated speed. However, note that if the cable does not support 
1 Gbps speed, you may need to replace the cable also. Usually, the network devices fall back to 
mutually acceptable speeds.

14. If a user complains that he is not able to connect to his Windows 7 computer remotely the reason 
may be Windows Firewall restricts communication between your computer and the Internet, you might 
need to change settings for Remote Desktop Connection so that it can work properly.

a. Open Windows Firewall by clicking the Start button Picture of the Start button, and then 
clicking Control Panel. In the search box, type firewall, and then click Windows Firewall.

b. In the left pane, click Allow a program or feature through Windows Firewall.

c. Click Change settings. Administrator permission required If you're prompted for an 
administrator password or confirmation, type the password or provide confirmation.

d. Under Allowed programs and features, select the check box next to Remote Desktop, and then
use the check boxes in the columns to select the network location types you want to allow 
communication on.

e. Click OK.

4.6 Given a scenario, troubleshoot operating system problems with appropriate tools

1. While preparing for dual boot with Windows 2000 Professional, note the following points:

a. Windows 2000 must be installed on a separate volume. If a separate volume is not available, 
repartition the hard disk suitably, and reformat. You also need to take suitable backup.
b. If you want to have dual boot between Windows NT 4 and Windows 2000 as the only 
operating systems, ensure that Service Pack 4 is installed on Windows NT 4. This is required 
since Windows 2000 upgrades the NTFS to NTFS 5. NT4 requires Service Pack 4 to read and 
write to NTFS 5.
c. You must install Windows 2000 only after installing MS-DOS or Windows 95. 

2. By default, you can start recovery console on a PC using Windows 2000 OS using,

a. The Windows 2000 Professional Setup Disks
b. From the CD ROM drive using Windows 2000 Professional CD (if the CD –ROM drive is 
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bootable).
Also, you can have “Recovery Console” as a start up option by typing \i386\winnt32.exe 
/cmdcons at the command prompt, after switching to the CD ROM drive letter. 

3. Fault tolerance boot disk is a floppy disk that enables you to boot a computer in the event that the 
first disk in a mirrored volume fails. If you mirror the installation folder in a Windows 2000 Server, you
will not be able to boot because boot.ini points to the first volume. Therefore, you need to create a fault 
tolerance boot disk that contain an appropriately edited Boot.ini file, that points to the mirrored volume. 

4. If you fail to boot, first try to boot in Safe Mode. If it doesn’t work, try booting to Last Known Good 
Configuration. If both fail, you can try using Recovery Console. 

5. If your Microsoft Windows XP-based computer does not start correctly or if it does not start at all, 
you can use the Windows Recovery Console to help you recover your system software.

6. Automated System Recovery (ASR) is a part of an overall plan for system recovery so that you are 
prepared if the system fails. ASR should be a last resort for system recovery. Use ASR only after you 
have exhausted other options. It is recommended that you use ASR only if all other options to repair the 
system (such as Last Known Good, and Safe Boot) have failed. 

4.7 Given a scenario, troubleshoot common security issues with appropriate tools and best 
practices.

1. Blue screen messages are also called STOP messages. You will not be allowed to proceed, when a 
blue screen message appears. The most likely cause of blue screen messages are:

a. Boot sector virus
b. IRQ/ IO address conflicts.

You can check for any boot sector virus, and also for any conflicting IRQ / IO addresses. 

2. System Restore automatically track changes to your computer and creates restore points before major
changes are to occur. To create a restore point, System Restore takes a full snapshot of the registry and 
some dynamic system files. For example, restore points are created before new device drivers, 
automatic updates, unsigned drivers, and some applications are installed.
To create a System Restore Point in Windows XP, use the sequence, Start | All Programs |Accessories | 
System Tools, and then click System Restore. 

3. System Restore takes a “snapshot” of critical system files and some program files and stores this 
information as restore points. You can use these restore points to return Windows XP to a previous state.

4. The automatic restart option in Windows XP is enabled by default. As a result, if there is any major 
error, the Operating System will automatically restart. This can be disabled using System applet in the 
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Control Panel. 
If an older program doesn't run correctly, use the Program Compatibility Wizard to simulate the 
behavior of earlier versions of Windows.

5. A POST test card is a small diagnostic tool that displays error codes generated during the Power On 
Self Test. These errors, called POST codes, correspond directly to a test that has failed and can help 
determine what piece of hardware is causing an issue. Most POST test cards plug directly into 
expansion slots in the motherboard while a few others connect externally via a parallel or serial port. 
Also Known As: Power On Self Test card, POST card, POST diagnostic card, checkpoint card, port 80h 
card

4.8 Given a scenario, troubleshoot, and repair common laptop issues while adhering to the 
appropriate procedures

1. Laptops, being mobile, usually participate on more than one network, and often use a static IP 
address at one location and a dynamically assigned IP address at another. For example, your computer 
might use dynamic addressing (DHCP) at the office but need to use a static IP address when at home to 
connect to a broadband ISP.

2. Most laptop computers require a function key or software command to activate/deactivate the laptop 
video output signal. Usually, the activation/deactivation command acts as a toggle switch: repeat the 
command to display the image on the internal laptop display, the external display (projector) or both 
displays simultaneously.
Examples: Acer: Fn+F5, Dell: Fn+F8 will activate/deactivate laptop/external display.  

3. The nickel cadmium battery, known as NiCad , used to be the most common type of laptop battery. 
NiCad batteries could easily be ruined by being left on the charger after they had reached full charge, or 
by being recharged before they were completely dead. The latter problem, called the "memory effect," 
meant that if you recharged your laptop battery before it had run completely down, it would remember 
the point at which you put it back on the charger, and only discharge that far the next time you used it.

4. The nickel metal hydride (NiMH) laptop battery could hold considerably more power than NiCad, 
but they still had something of a memory effect, although to a lesser extent

5. Lithium ion (Li-Ion) is the latest technology for laptop batteries. They are considerably lighter and 
does not exhibit memory effect. The Li-Ion laptop battery lasts considerably longer than its 
predecessors. If your laptop supports Li-Ion battery, then it is a recommended choice. 

4.9 Given a scenario, troubleshoot printers with appropriate tools

1. Some of the frequently encountered problems using laser printers and probable causes are as given 
below:
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I. Speckled pages: The causes for this may be
a. The failure to clean the drum after printing properly, or 
b. The drum might have developed scratches.

II. Blank pages: The causes for white pages may be,
a. The toner would have dried out, replace the toner. 
b. The transfer corona, that is responsible for transferring the toner to the drum might 
have failed. c. The High Voltage Power Supply (HVPS) failure will also result in white 
pages.

III. Ghosted Images: Ghosting occurs when previously printed pages are printed again, though 
much lighter than the present image. The most likely cause is that the erasure lamp might not be 
working properly, thus leaving some charges representing the earlier image left on the 
photosensitive drum before new image is written. Also check the cleaning blade, which is 
responsible for scaping the residual toner.

IV. Smudged images: If the fusing fails, the toner will not bond with the paper. Check the 
halogen lamp responsible for heating. 

2. The following are the 6 steps in the ElectroPhotographic (EP) print process of Laser Printer:

a. Cleaning: Cleaning the photosensitive drum includes residual toner left on the drum and 
removing the electrical charges left out on the drum. The physical cleaning is done with a rubber
blade and the electrical charge cleaning is done with erasure lamps.

b. Charging: The next step in printing, is to charge the photo sensitive drum with high negative 
charge, this is done with the help of a corona wire.

c. Writing: A laser (type 3) sweeps the entire length of the drum, creating the static image of the 
matter to be printed. The places where the laser travel, the highly charges are neutralized. Other 
places of the drum, it remains highly negatively charged.

d. Developing: Now drum gets in close proximity to the toner. Because the toner is negatively 
charged, it gets attracted to the areas where the drum is neutral. It will not be attracted to the 
places where the drum is highly negatively charged. Thus the image of the page to be printed 
formed on the photosensitive drum.

e. Transferring: Now, the toner on the drum gets attracted toward the paper, by using highly 
positive charges developed on the surface of the paper. The "transfer corona" is used to generate 
highly positive charge on the paper surface and to attract the toner from the drum. Thus the 
image of the page to be printed formed on the paper. But still, the toner is loose and can get 
easily smeared.
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f. Fusing: In order to permanently bond the toner particles to the paper, the paper is passed 
through rollers. One of the rollers, the non stick roller is heated by a high intensity lamp, 
generating the heat necessary to bond the toner to the surface of the paper. 

3. When a printer is installed on a network, default printer permissions are assigned that allow all users 
to print. Because the printer is available to all users on the network, you might want to limit access for 
some users by assigning specific printer permissions. For example, you could give all non-executive 
users in a department the Print permission and give all managers the Print and Manage Documents 
permissions. You can also deny print permission to all others. In this way, all non-executive users and 
managers can print documents, but managers can also change the print status of any document sent to 
the printer. 

4. Normally, the printer supplier provides a driver that goes with the XP OS. It is always preferable to 
use the driver supplied by the device manufacturer along with the printer.
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